3D Pro
User Guide
The 3-D Pro will only operate as instructed on clean power.
Please make sure that the correct cutter and jaw combination are in place before cutting the key!!!!

It is recommended that Safety Glasses be worn at all times when operating this machine.
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Checking your new 3D Pro upon arrival
Please check for any damages caused during shipping, if any damage is found, please report it immediately. If
damage is not reported on the day of arrival, the customer will be responsible for any repair costs. Calibrate
the machine when your finished setting up the software as instructed in this User Guide. The tracing function
for duplicating keys works only on metal; don’t try to duplicate painted or plastic keys.
• Make sure the plastic covers on the 3D Pro are not cracked or broken.
• Check that the tracer swing arms flip up and down properly
• The machine should have no major scratches or markings
• Any damage or missing parts should be reported upon day of arrival

Contents
1 x 3-D Pro Machine
1 x Jaw 1 (High security Jaw)
1 x Jaw 2 (Standard Jaw)
1 x Jaw 3 (VW Jaw)
1 x TR 2.5 Single Ended Cutter

1 x Stylus
1 x Tip Stop
1 x USB Cable
1 x AC Power Cord

Optional Parts: Bolt-Down Kit - Laptop Mount - Tibbe Adapter – Tubular Jaw
Newer 3D Pro Xtreme key machines have a hard wired motor control cable but on older machines the 9 pin
serial cable exiting the left side of the machine should be plugged into the 9 pin serial plug on the left side of
the jaw table. (see pics below) Tighten the two small flathead screws from the cable to the serial plug. Do not
plug the 9 pin serial cable into a computer, this will short out the control board.

Computer Hardware Requirements
• Windows XP - SP2 or higher, Windows Vista, 7 and 8 with 2 GB of RAM
• We recommend a minimum 1,500 watt pure sine wave inverter to extend the life of your 3D Pro and laptop.
• If using an inverter to power the 3D Pro, make sure the inverter is properly grounded to the vehicles chassis otherwise
you may experience problems with the operation of the machine. Please follow your inverter manufactures installation
instructions and refer to the “Using an Inverter” page of this manual.

When cleaning key shavings from the machine, please use a brush or vacuum, please do not use compressed
air as doing so will likely blow shavings into the machine and over time causing problems such as causing
electrical shorts or gumming up the axis’ to where the tables could seize. Please use safety glasses.
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The Emergency Stop (On/Off) Button
The Emergency Stop acts as the On/Off
Switch. The “Emergency Stop Button” is
situated on the left hand side of the machine.
In an emergency, hit the button to turn off
the machine. To turn the machine on, twist
the button clockwise and it will pop out. To
turn the machine off, press the button. Note
that if you simply want to cancel a key
cutting process that using the stop button on
the software is a better option.

Software Installation
If you have Windows 8 or 8.1 Press Ctrl + Alt + Delete on your keyboard. Click the Power icon
at the bottom right and then Shift + Click the Restart option. On the next blue screen “Choose
an option”, click Troubleshoot > Advanced Options > Startup Settings and then click Restart.
On the Startup Settings press F7 or 7 on your keyboard:

Windows 8 Driver installation

Perform these steps before installing
software if you have Windows 8 or 8.1

1) Turn on the computer and go to the desktop. Press Ctrl + Alt + Delete on your keyboard.
Click the Power Icon

at the bottom right and then Shift + Click the Restart button.

2) On the next blue screen “Choose an
option”, click Troubleshoot

3) Then click Advanced Options
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4) Then click Startup Settings

And then click Restart

5) On the Startup Settings press F7 or 7
on your keyboard.

Now install and configure the software and
drivers.

Downloading and installing the software:
1. Go to LASERKEYPRODUCTS.COM and on the right side of the main home page under Popular
Downloads click 3D Xtreme Software.
2. Next to v15 Click ‘Purchase and Download Now’ then click ‘Add to Cart’ then click ‘Checkout’
then provide Company and other information and click ‘Submit the Information’ and in the
‘Discount Coupon’ box use the coupon code provided in the white envelope received with new
machines and select ‘Use Coupon’ payment method and click ‘Continue’ and then ‘Confirm
Order’ and then ‘Download Now’.
3. The coupon Code will be in the white envelope received with new machines.
(To purchase codes or software updates follow the same instructions and use a credit card)
4. Download, extract and Run the downloaded file and follow the on screen instructions.

Be sure to choose 3D Xtreme S during the installation.
(A video of this procedure can be found on the Xtreme download page)
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Software Activation
After installation, Double-click your new desktop icon you may see License Configuration..
Some downloaded versions may not ask to activate.

1. Read and follow the activation instructions. You will be instructed to email us your site code
and wait for a site key. Site codes are released Monday through Friday 9am – 5pm Central
Standard Time and often on weekends as well.
2. If in the activation window ‘Electronic registration’ or ‘Email Registration Request’ doesn’t
work then copy and paste the site code to your webmail such as Gmail, Yahoo, or Hotmail and
wait for a site key to be sent back to you, then copy and paste the site key in the activation
window and click ‘validate’
3. Once the software is activated you may get an error stating that the software cannot
connect to the machine. Follow the steps on the next page to configure your Device Manager.
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Driver Installation
If you have Windows 8 or 8.1 Press Ctrl + Alt + Delete on your keyboard. Click the Power icon at the
bottom right and then Shift + Click the Restart Button. On the next blue screen “Choose an option”,
click Troubleshoot > Advanced Options > Startup Settings and then click Restart. On the Startup
Settings press F7 or 7 on your keyboard
After installing the 3D Pro software, follow these steps to get the machine communicating with the
computer. These steps can also be used if you get a “Motion board not connected” Error. It is
important make sure the machine is hooked up to the computer, powered on and configured in the
device manager properly before starting the software for the machine.

1. Connect power cord to the left side of the 3D Pro and twist out the Red Emergency Stop.
2. Connect USB cable to the back of your 3D Pro and to any USB port on your computer.
3. Your computer should at this point install the driver automatically, if not the “Found New
Hardware Wizard” will appear. Click install from specific location and Browse to “c:\laser key
products\3d pro windows drivers” and click next and finish. If an unsigned driver warning
appears then select “Continue Anyway”
4. If the “Found New Hardware Wizard” didn’t appear, then open the Device Manager from
the desktop icon labeled “Device Manager” and look for “Other Devices > Motion Controller”
Right Click “Motion Controller” and Click “Update Driver” Choose install from specific location
and Browse to “c:\ laser key products\3d pro windows drivers” and click next then finish. If an
unsigned driver warning appears then select “Continue Anyway”
5. If the driver installed correctly you will see “Ports > SSUSB-RS422 Serial Communication
Converter board”. Move onto “Finding the correct COM port” on the next page.

(This is what your device manager should look like after installing the drivers)
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Driver Configuration
After installing the 3D Pro software and drivers, follow these steps to get the machine communicating
with the computer. These steps can also be used if you get a “Motion board not connected” Error.

1. Open “Device Manager” from the desktop icon and look under “Ports” for “SSUSB-RS422
Serial Communication Converter board” then right-click it and click properties.

2. Under “Port Settings”
change the Bits per second to
57600

3. Click the “Advanced” button and set the COM number to 2
and press OK, and OK again on the Properties page and exit
the Device Manager

4. Close the Device Manager window, then push in the red button on the left side on the
machine and unplug the USB cable going to the computer from the machine, wait 30 seconds
then twist the red button out and plug the USB cable back into your computer and wait 30
more seconds and then start the software.

(This is what your device manager should look like after setting the COM port)

Page 8 of 58

Error Connecting
COM Error
If you start your software and the software says “Communications Error” or “Board Not
Found” check these options:

1. Power is going to your 3D Pro from the
power outlet.
2. The emergency stop button is disengaged
(twisted out according to the arrows)
3. The USB cable from the 3D Pro is plugged
into a USB port on your computer.
4. Multiple instances of the 3D Pro software
may be running causing a conflict, check this
by opening Task Manager (Control Alt
Delete on your keyboard and then clicking
start Task Manager.)
Select any items labeled “3D Pro
Xtreme.exe” and then click “End Process”
5. Unplug the USB Cable for 15 seconds,
plug it back in and wait 15 more seconds
and then start the software for the machine.
6. Repeat the Driver Installation and
Configuring COM Port instructions on the
previous pages.
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If you still get error connecting then right click the desktop icon for the 3D Pro,
click Properties and then click the compatibility tab, set the settings shown below
and press ok. Try to start the software again.

Changing the Cutter and Calibration Stylus
“The Collet” Holds the Cutter or Stylus in the spindle. To
remove the cutter or stylus, first hold the red knurl knob
on the top of the machine sticking up through the lid.
Then press in “spindle stop button” on the front of the
head unit. Now turn the knob on top with your hand until
you feel the spindle stop button press all the way in. Turn
the knob counter clockwise and you will feel the collet
loosen. The cutter or stylus can now be removed.
Machines that do not have the “spindle stop button” will
have a red “knurl knob” underneath the head unit that
you will use together with the top knurl knob to loosen
the “Collet” and remove the cutter.
When replacing the cutter or stylus, insert it into the collet and slide it up until it stops. Press
the spindle stop button in until it catches so you can tighten the collet back up on the cutter, it
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does not have to be extremely tight, hand tight should be sufficient. If one of the ends of your
TR62.2 double ended Jaw 2 cutter is broken, you will notice that it inserts further into the
collet than normal and you may have to bring the cutter down about a quarter of an inch if
you get an error when trying to cut.

Changing Tracer
When changing the tracer, tighten the set screw that holds the tracer tip in place above the installation mark.
The tracing function for duplicating keys works only on metal; don’t try to duplicate plastic keys.

Single ended tracer tip installation:
1. Loosen Set Screw on tracer Swing Arm and remove current tracer

2. Install the Tracer into the Tracer Swing Arm to the installation mark and tighten the set
screw.

(Installation mark indicated by the arrow)
The mark should not be visible after installation

3. Calibrate the tracer after changing tracer tips.
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Changing Jaws
The main Jaw 2, 3, 1 assembly can be removed
for cleaning or to insert another jaw such as the
Tubular Jaw. When changing a jaw, look behind
where the jaw is attached, you will notice a red
“T knob” Turn the “T knob” counter clockwise
to release the lock pin, the jaw can be now be
removed from the table by sliding it off to the
right. Replacing the jaw is the same operation
in reverse order, if the jaw will not slide into
place, make sure the angle of the lock pin
matches the angle of the dovetail, and lock pin
is not protruding (like the one in the pic)

Calibrating the 3D Pro Xtreme
If you get “Obstruction Detected” or “Out of Range” errors you may need to calibrate, make
sure you are calibrating with the stylus and not the cutter when calibrating.

Calibrating Cutter for Jaw 1:
1. Clean any shavings or debris from jaw (Any metal
shavings, dirt or grease that the stylus touches will
take an incorrect reading). And open Jaw 1 all the
way!
2. Put the Stylus in the collet. The Stylus must be used
to calibrate. Do not use cutters to calibrate or else
your keys will cut wrong.

This is the Stylus.

3. Make sure the Jaw 1 tracer arm is up, if the tracer arm is down, you will receive an error
message.
4. On the main screen at the top left, click on
the “Operations” menu and
choose “Calibrate Machine”
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5. When the window appears asking to “Select
Jaw” insert the correct jaw number in the
window, 1 (1, 2, or 3 depending on which jaw
you want to calibrate) as we are calibrating Jaw
“1” we would enter “1” and click “OK”

6. The stylus will touch the jaw in three places. After the procedure is complete, at the lower
left portion of the software, it will say “Update in Progress Please Wait” give it a moment
and don’t click anything or it can possibly freeze the software and you will have to restart it.

Calibrating Tracer for Jaw 1:
1. Always have a “Cutter” or “Stylus” installed while
calibrating the Tracer, do not leave the collet empty or it
will get in the way of the Tracer.
2. Flip the tracer arm down with the “red knurl knob” on
the left side of the head.
3. On the main screen, click on the “Operations”
menu and choose “Calibrate Tracer”
4. When the window appears asking to “Select
Jaw” insert the correct jaw number in the window,
(1, 2, or 3 depending on which jaw you want to
calibrate) as we are calibrating Jaw “1” we would enter
“1” and click “OK”
5. The tracer tip will touch the jaw in three places.
After the procedure is complete it will read,
“Update in Progress Please Wait” give it a moment and
don’t click anything or it can possibly freeze the software
and you will have to restart it.
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Calibrating Cutter for Jaw 2:
1. Clean any shavings or debris from
jaw (Any metal shavings, dirt or grease
that the cutter touches will take an
incorrect reading)
2. Close the Jaw 2 so that it is
completely shut with the ‘A’ side facing
the cutter wheel
3. Flip the Shoulder stop up and the Tip
stop down as pictured.
4. On the main screen, click on the
“Operations” menu and choose
“Calibrate Cutter”
5. When the window appears asking to
“Select Jaw” insert the correct jaw
number in the window, (1, 2, or 3
depending on which jaw you want to
calibrate) as we are calibrating Jaw “2”
we would enter “2” and click “OK”

Jaw 2 may need minor adjustments to space or depth after
calibrating to be correct. Refer to the section “Checking and
Adjusting the “Tracer” for instructions.

6. The cutter wheel touches the front of the A side of the Jaw 2 and then moves to the left and
touches the shoulder stop then goes home.
After the procedure is complete it will read “Update in Progress Please Wait” give it a moment
and don’t click anything or it can possibly freeze the software and you will have to restart it.
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Calibrating Tracer for Jaw 2:
1. Flip the Jaw 2 Cutter Wheel Tracer
up. Clean any shavings or debris from
jaw (Any metal shavings, dirt or grease
that the cutter touches will take an
incorrect reading)
2. Close the Jaw 2 so that it is
completely shut with the ‘A’ side facing
the cutter wheel
3. Flip the Shoulder stop up and the Tip
stop down as pictured.
4. On the main screen, click on the
“Operations” menu and choose
“Calibrate Tracer”
5. When the window appears asking to
“Select Jaw” insert the correct jaw
number in the window, (1, 2, or 3
depending on which jaw you want to
calibrate) as we are calibrating Jaw “2”
we would enter “2” and click “OK”
6. The cutter wheel touches the front of
the A side of the Jaw 2 and then moves to
the left and touches the shoulder stop
then goes home.
After the procedure is complete it will read
“Update in Progress Please Wait” give it a
moment and don’t click anything or it can
possibly freeze the software and you will
have to restart it.

Jaw 2 tracer may need minor adjustments to space or depth
after calibrating to be correct. Refer to the section “Checking
and Adjusting the “Tracer” for instructions.
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Calibrating Cutter for Jaw 3:
1. Clean any shavings or debris from jaw (Any
metal shavings, dirt or grease that the stylus
touches will take an incorrect reading). And
open Jaw all the way!
2. Put the Stylus in the collet. The Stylus must
be used to calibrate.
Do not use cutters to calibrate or else your
keys will cut wrong.
3. Make sure the tracer arm is up, if the
tracer arm is down, you will receive an error
message.
4. On the main screen, click on the
“Operations” menu and choose “Calibrate
Machine”
5. When the window appears asking to
“Select Jaw” insert the correct jaw number in
the window, 1 (1, 2, or 3 depending on which
jaw you want to
calibrate) as we are calibrating Jaw “3” we
would enter “3” and click “OK”
6. The stylus will touch the jaw in three
places. After the procedure is complete it will
say “Update in Progress Please Wait” give it a
moment and don’t click anything or it can
possibly freeze the software and you will
have to restart it.
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Calibrating Tracer for Jaw 3:
1. Never have a “Cutter” or “Stylus” installed
while calibrating the Tracer, leave the collet
empty or it will get in the way of the Tracer
and cause an error.
2. Flip the tracer arm down with the “red knurl
knob” on the left side of the head.
3. On the main screen, click on the
“Operations” menu and choose “Calibrate
Tracer”
4. When the window appears asking to “Select
Jaw” insert the correct jaw number in the
window, (1, 2, or 3 depending on which jaw
you want to
calibrate) as we are calibrating Jaw “3” we
would enter “3” and click “OK”

5. The tracer tip will touch the jaw in three
places. After the procedure is complete it will
read, “Update in Progress Please Wait” give it
a moment and don’t click anything or it can
possibly freeze the software and you will have
to restart it.
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USING JAW 1
“Jaw1” is always used for ALL high security
(laser style keys) except Volkswagen (VW)

The Cutter used most
with Jaw1 is always
the TR2.5 single
ended Cutter:

Clamping High Security Keys in Jaw 1
Using the “Tip Stop”
When you selecting High Security keys, the software
will tell you which slot to place the “Tip Stop”
After selecting the key, look under the “Step 2”
column on the home screen, you will find the tip stop
number next “Stop” under the cutter image.
It will read “Tip 1”, “Tip 2”, or “Tip 3”
Place the tip stop in the correct slot, lay the key flat in
the jaw and slide the key forward until it touches the
tip stop then tighten the jaw using the red knob on the
right side of the Jaw 1 and then remove the tipstop.
Warning: Do not forget to remove the tip stop before
tracing or cutting a key. The tracing function for duplicating
keys works only on metal; don’t try to duplicate plastic
keys.

This is the
“Jaw 1 Tip Stop”
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Jaw 1 Tipstop Example (tipstop 2):

Using the Jaw 1 “Shoulder Stop”

When selecting keys that calls for a
“Shoulder” stop, place the key in
the jaw and slide it forward until
the shoulder of the key is touching
the front of the jaw. Tighten the red
knob to lock the key in place.
Jaw 1 “B” Side

When a Mercedes 2 Track or BMW HU92 2 Track key is selected, it requires that the Jaw 1 “B”
side be used. Open the Jaw 1 and slide the movable side of the Jaw 1 top off the Jaw 1 and
slide it back on with the B side on the left.
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Using Jaw 3
(Jaw 3)
When a VAG (HU66) key is selected, it requires Jaw 3 to be used. Insert the key into Jaw 3 and slide
the key forward until the shoulder of the key and tighten the red knob on the right of Jaw 1.

USING JAW 2
When loosening the Jaw 2 to clamp keys be careful not to unscrew the Red T Knob too far,
doing so will cause the moving Jaw 2 top to slide out of the fixed Jaw 2 inner base and will
require special instructions to reassemble.
Jaw 2 Tracer
To cut a key leave the Jaw 2 cutter
wheel tracer down.
To trace a key for duplication lift the
Jaw 2 cutter wheel tracer up.
Changing Jaw 2 Clamp
To change which jaw clamp faces the
cutting wheel all you have to do is
loosen the jaw 2 and firmly twist the
jaw 2 in any direction until the desired
jaw clamp is facing the cutting wheel.
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The Jaw 2 shows on the front of the jaw which side is facing the cutter that will be used to
clamp the key. Whichever letter you see facing you is actually the letter facing away from
you as shown below on the top of the Jaw 2 (your actual jaw may not have letters on top,
they are shown in this guide for reference). Most keys can be clamped multiple ways. If one
side doesn’t clamp a key properly then try another side. Also, the arrow you see on the front
is the direction the jaw tooth is coming from. B Side has an up arrow indicating the tooth is
pointed up. D Side has an up arrow indicating the tooth is pointed down.

The A, B, C, and D Sides of Jaw 2
Always clamp single sided keys all the way to the back of the Side A or C flat clamps. The
different sides of the Jaw 2 clamp a variety of key shapes. The A and C sides are flat clamps
and the B and D sides clamp key on a tooth protruding from the bottom and top of the clamp.

A Side

B Side
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C Side

D Side

Notice that the Jaw 2 B and D sides have teeth that can help clamp double sided keys straight.
Double sided keys can also be clamped in the A or C flat clamps but they often have problems
clamping the second side if there are no one cuts or if the key has many deep cuts not allowing
for good clamping on the milling (milling highlighted in red below). When the center groove of
the key is down the middle of the key then it doesn’t matter if the key is clamped from the B
Side bottom tooth or the D Side top tooth, it will clamp the same. (Center grooves in blue)
When using the teeth, you will clamp however makes the key sit further out of the Jaw 2.

Center groove on the Left

Center groove on the Middle

Center groove on the Right

Clamp on B Side Bottom Tooth

Clamp on B or D Side

Clamp on D Side Top Tooth

Bottom or Top Tooth
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Circled in RED is the milling of this Y157 Key.
The milling is the thinnest part of the key
along the edge where the cuts go.

Here is an example of a Schlage SC1 key clamped in Side A:
Always clamp single sided keys all the way to the back of Side A or C.

Side view from the right

Side view from the left
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Here is an example of a B106 P1115 key clamped in Side B:

Side view from the right

Side view from the left

Here is an example of a DWO4RAP key clamped in Side D:

Side view from the right

Side view from the left
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Jaw 2 Trace Types

Exact Duplicate: It does not matter how a key is clamped in the Jaw 2 when using Exact
Duplicate trace type as the machine will detect how the key is clamped and trace accordingly.
The blank key needs to be clamped the same way as the original key. Most keys can be
clamped on A Side either all the way to the back of the Jaw 2 or on the milling. There are four
sides because different types of keys will sometimes clamp better on the different lettered Jaw
2 sides. Side C is flat like Side A but shallower for clamping thin keys such as keys for filing
cabinets and safety deposit boxes. If you clamp a single sided key into A side and find that the
milling is recessed into the clamp then try clamping with C side. Exact Duplicate trace type
does show cut results but they are only accurate if the key is clamped all the way to the back
of the Jaw 2.

Manufacturer specifications: Traces a key and displays the closest measured cuts of the key.
The resulting key blank gets cut to the original manufacturer space and depth specifications.
This is useful for restoring a worn key or finding what the cuts of a key are. Single sided tip and
shoulder stop keys must be clamped all the way to the back of A or C side for this trace type.
Double sided tip stop keys may be clamped either on the teeth of B or D sides, clamped on the
milling of A or C sides, or clamped all the way to the back of the Jaw 2 on A or C sides for this
to work. Double sided shoulder stop keys are not supported by this trace method.
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Double sided keys will not automatically align in the Jaw 2 when clamped all the way to the
back of the Jaw 2 if there is no 1 depth toward the tip of the key, therefore clamping on teeth
and on the milling are a better option for double sided keys.

Clamping Non-High Security “Shoulder Stop” Keys in Jaw 2
When you select a standard security key
from the menu, the software will tell you
which “Stop” to use, “Shoulder” or “Tip”
This is an example of a Shoulder Stop key:
Slide the key forward until it stops on the
shoulder of the key. Tighten the red knob
on top until the key is clamped firmly.
Lower the shoulder stop before cutting or
tracing.

Clamping Non-High Security “Tip Stop” Keys in Jaw 2

This is an example of a Tip Stop key:
Insert the key into the jaw and raise the
“Tip Stop” slide the key forward until it
touches on the stop. Lower the tip stop
before cutting or tracing.

Remember to fold the “Shoulder” or “Tip” Stop back down before you start to “Trace” or “Cut” a key
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Sometimes, depending on the blank
used, the key will try to twist out of the
jaw or otherwise not clamp properly. A
shim can be used to hold the key tight as
illustrated. In the example to the right we
are using a hex wrench to shim the key.

Laser Cut

Plunge Cut

Cut Types

Best Adapter

Slide the Best Adapter into the front of the Jaw 2 and stop Best keys on the recessed tip
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Tubular Jaw

Tubular Cutter (Cutter 4)

Tubular Tracer

Make sure the single ended tubular tracer is installed into the Tracer Swing Arm just under
where the mark was made to where the tracer tip is just under half an inch sticking out of the
swing arm. Insert the Tubular Cutter.

After installing the Tubular Tracer CALIBRATE THE TUBULAR TRACER ON JAW 1
(Tubular settings are shared with Jaw 1 calibration settings)
The Tubular tracer can be used to trace all keys, it is not necessary change out the tracer when
changing jaws. If you alternate between tracers you will have to calibrate each time
You will have to calibrate the new tracer for Jaw 3 also unless you plan to alternate between
tracer types then you only have to calibrate for Jaw 1

Page 28 of 58

Using the Tubular Jaw
Loosen the red t-knob behind the main jaw assembly, slide off the main jaw assembly, and
slide on the Tubular Jaw. There is a spacer on the left side of the Tubular Jaw that stops on the
silver screw. Tighten the red t-knob to lock the Tubular Jaw into place.

Supported
Blanks:
ILCO 1137B
LSDA
1137B
JMA CHI-1T

Clamp keys in the jaw with the notch
of the key placed into the cut out at
the back of the jaw. Tighten the red
knob on the front until the screw is
firmly holding the key in place.

Selecting Tubular Keys in the Software

To select A Tubular key click the
‘Type/Manufacturer’ tab under ‘Step 1:
Select Correct Key Type’ and choose which
type of Tubular to use.
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Then select the key blank being used.

After placing the tubular key in
the tubular jaw then click ‘Trace’
or enter cuts using the keyboard
and click ‘Start’ when ready to
cut.

Tubular Key DSDs
405, 406, 410, 411, 412, 413, 414, 415, 416
To search by DSD click ‘Search’ at the top left, enter a DSD number and click ‘Search’

The Tubular Jaw is supported by v5.38.8 or higher
(v15 or above)
To check your software version go to ‘Help > About’
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Tibbe Key and Tibbe Adaptor

This enables us to insert the key blank into the adaptor “sideways” and rotate 90° into place.
Cutting a FORD “Tibbe” Key - Silca FO21 (DSD 358)
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On the main screen you will see three tabs “Automotive” “Type/Manufacturer” and “Search”
Click on “Commercial/
Domestic” and choose “Ford”
from the drop down menu.
Now click on “FO21” (DSD
358) to open up the “Main
cutting screen” Enter the
depth of your cuts starting
with “1” as the cut nearest
the shoulder of the key.
Once you have entered the
cuts, click “Enter” and the
“Start” button will appear.

Click on the start button and you will get a check box “Click
OK if Jaw 1 and TR2.5 cutter installed" If you have the
correct jaw and cutter installed, click “OK” to cut the key.
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Cutting a JAGUAR “Tibbe” Key - Silca TBE1 (DSD 356)
Inserting the Jaguar Tibbe Key into the “Tibbe Adaptor” is exactly the same as inserting the
Ford Tibbe Key and choose the Jaguar from the “Type/Manufacturer” tab.
Click on “Commercial/
Domestic” and choose
“Jaguar” from the drop
down menu and click
on “S32YSP” (DSD 356)
to open up the “Main
cutting screen”
Enter the depth of your
cuts starting with “1”
as the cut nearest the
shoulder of the key.
Once you have entered
the cuts, click “Enter”
and the “Start” button
will appear.
Click on the start button and you will get a check box “Click
OK if Jaw 1 and TR2.5 cutter installed"
If you have the correct jaw and cutter installed, click “OK” to
cut the key. The “first side” of the key will now be cut.
When the first side of the key has been cut, loosen the “Set Screw” and slide the key back out
of the tip of the adaptor just far enough to rotate it a full 180°.
Push the key back into the adaptor tip and lock the key in place by tightening the “Set Screw”
(do not over tighten) When the key has been cut, loosen the “Set Screw” and slide the key
back out of the tip of the adaptor, rotate 90° and remove the finished key.
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Selecting keys in the software
There are three ways to select keys in the
3D Pro software, if you can’t find a key
one way then try another. If you try to
select a key from the year make and
model selector only to find the year you
have is not listed then try the closest year
or make of vehicle or select the key from
one of the other two key selection tabs.

The Type/Manufacturer tab allows you to
select a key by blank name. After clicking
this tab select a manufacturer

The Search tab allows for selecting keys
by DSD number, blank name, year make
and model name and more.
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Saving and Loading Customer Keys Database
Keys can be saved in the 3D Pro software for later use. Say, when a customer locks their keys
in their car or lost their keys you would be able to load keys you saved from the 3D Pro
software to cut and deliver to the customer.
The Customer Keys Database does not come installed with the main 3D Pro software and is
downloaded and installed separately. The Customer Keys Database is stored in the “C:\Laser
Key Products” folder on computer running the machine. This file must be backed up
periodically to prevent data loss.
Backing up the Customer Keys Database:
Go to the “C:\Laser Key Products” folder and copy the “Customers.mdb” to a USB Drive or
Online Backup.
Restoring the Customer Keys Database:
Copy the backed up “Customers.mdb” from the USB Drive or Online Backup to the “C:\Laser
Key Products” folder.
Installing the Customer Keys Database:
Go to the downloads section for the key machine at LASERKEYPRODUCTS.COM and download
the Customer Keys Database and install once finished downloading. This installation will place
a file labeled “Customers.mdb” into the “C:\Laser Key Products” folder.

Saving Keys:

Select a key as normal and fill in the cuts by using a
code, tracing a key, or entering the cuts manually.
Then click File and Save Key.
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Enter the available customer data into
“Step 1:” on the left side on the
Customer Keys window.
Leave ID blank, this is used by the
program.

Click “Add” and another button will
appear labeled “Done” click it to finish
adding the customer.
The ID will be generated by and can be
used to search for this customer when
loading a key.

Next, on the right side on the
customer keys window click the
“Add” then “Done” buttons to add
the key to the selected customer.
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Loading customers and their keys:

To load a previously saved key click “File” and
“Load Key”

Type a search term into any of the customer
data fields and click the “Search” button.
All fields are searchable including the
generated ID.

Click the requested customer from the search
results box at the bottom of the customer
information box.
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After selecting a customer, the keys box
will show keys that are saved to the
selected customer. Click on the key that
you want to load.

Then click the “Load Key” button at the
bottom.

This key will then become selected in the main part of the 3D Pro software with the cuts filled
ready to cut. Load the key blank as instructed in Step 2 of the 3D Pro software and cut the key.

SPACE AND DEPTH ADJUSTMENTS
The following pages will show you how to check and set your machine to cut and
trace perfectly.
Explaining the X, Y, Z Axis for Jaw 1 and Jaw 3
1. Jaw 1 uses three axes which are X, Y, and Z
2. The X axis is the movement from left and right and controls the depth.
3. The Y axis is the movement from front to back and controls the spacing.
4. The Z axis is the movement up and down and controls the height at which the cutter is
lowered.
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Explaining the X, Y, Z Axis for Jaw 2
1. Jaw 2 uses two axes which are X and Y.
2. The X axis is the movement from left and right and controls the spacing.
3. The Y axis is the movement from front to back and controls the depth.
All adjustments are in .001” (one thousandths of an inch)

The “Space” or “Depth” on either the “Tracer” or the “Cutter” can be adjusted by a maximum
of “.020” (20 thousands) either way (+ or -) plus or minus. You will need to know how to
measure keys with calipers.

Adjustments are made by going to “Operations > Space and Depth Adjustment” and the typing
1, 2 or 3 for Jaws 1, 2 and 3 and clicking OK.

Adjusting Space and Depth on Jaw 1 and Jaw 3
High security keys that are cut and traced on Jaws 1 and 3 uses a profile that can be shifted
along the space and depth.
We will use a High Security Honda key as an example of how to adjust Jaw 1.
In the 3D Pro software with this
Honda key selected go to: ‘File > Edit’
and at the bottom is the Depth and
Space Data (DSD)
On the next page is a visual
representation of this DSD.
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To measure the spacing
on a tip stop key like
the high security Honda
key set a caliper to the
space that you want to
measure using the
space data on the edit
page and the measure
from the tip toward the
bow. For a shoulder
stop key, measure from
shoulder to tip.

To measure a depth on a
high security Honda key,
find the space for the
depth you want to
measure and measure
from the edge of the key
to the edge of the cut.
Compare the reading
against the Cut Depth
info on the edit page.
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Now trace either a blank or OEM cut high security Honda key. It’s best
not to use an aftermarket key because it may not be cut to spec. In this
example we are tracing an OEM cut key.
At the bottom right hand corner of your 3D Pro software is a text box,
and at the bottom of this box are the readings for the trace, one line per
cut. The readings show the space, cut and tracer measurement. The
readings are shown in the order in which they have been traced.
A blank will read all zeroes measuring 352 all the way down the key.
An OEM key should always read ones in both 6th spaces measuring 311.
The 6th spaces will show in the middle of the readings list and we see in
the example that the key profile is off to the left by 3 thousandths of an
inch. The trace reading shows that the 6th space on side A measured to
308 thousandths of an inch when it is supposed to be 311 thousandths of
an inch. This in turn causes the 6th space on side B to be off as well. To
correct this we will make a space and depth adjustment to move the cut
profile to the right by 3 thousandths of an inch. This will make the 6th
space on side A measure 311 and the 6th space on side B measure 310.

[Trace Reading
Example]
(1,3);283
(2,5);253
(3,5);253
(4,4);268
(5,5);253
(6,1);308
(6,1);313
(5,5);256
(4,1);312
(3,5);256
(2,6);242
(1,4);269

To make this adjustment go to “Operations > Space and Depth Adjustment” type “1” and press “OK”

You will see the window shown above. Type “3” under “Tracer” next to “Depth Offset:” and
then press “Update”
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Adjusting space and depth for the Jaw 1 cutting is the
same as adjusting Jaw 1 Tracer accept that you will have
to cut a key, measure it, and make the adjustment. Cut a
high security to a random code or all ones and measure
as shown below. The tip of this high security Honda key
will have ones on both 6 space cuts (or along the whole
key if you cut to all ones) and should measure to 311.
Shown to the right is an example of how to measure a cut
high security Honda key at the 6th space on side A.
If the 6th space on side A measures less than 311 the
make a positive adjustment to move the keys profile to
the right if the measurement is more than 311 than make
a negative adjustment to move the key profile to the left.
Making adjustments affects all cuts.
Let us say that 6th space on side A is measuring to 314
then the adjustment will be made as shown below.
To make this adjustment go to “Operations > Space and Depth Adjustment” type “1” and press “OK”

You will see the window shown above. Type “-3” under “Cutter” next to “Depth Offset:” and
then press “Update”. Repeat the same process for spacing.
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Adjusting Space and Depth on Jaw 2
We will use a Schlage key as an example of how to adjust Jaw 2.
In the 3D Pro software
with this Schlage key
selected go to: ‘File > Edit’
and at the bottom is the
Depth and Space Data
(DSD)

Below is a visual representation of this key DSD:

To measure the spacing on a shoulder stop key like
the Schlage key, set a caliper to the space that you
want to measure using the space info on the edit
page and the measure from the shoulder toward the
tip. For a tip stop key, measure from tip to bow.

To measure a depth on a Schlage key, find
the space for the depth you want to measure
and measure from the edge of the key to the
edge of the cut. Compare the reading against
the Cut Depth info on the edit page.
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Cut a Schlage key to all ones and measure the depth with calipers. According the edit page for
the Schlage key, one depths should measure to 320 thousandths of an inch. If your key
measures too shallow, say 325 then make a negative adjustment to the cutter depth offset. If
your key measures too deep, say 315 then make a plus adjustment to the cutter depth offset.
Negative adjustments are made by putting a minus sign in front of the number used in the
adjustment box.

To adjust the spacing, cut a Schlage key to all ones with a 3 in the third space set your calipers
to .543 inches and measure from the shoulder to the tip and see if the 3 cut meets the
measurement. If the 3 cut is too far toward the shoulder of the key then enter a negative
number in the Depth Offset under CUTTER. If the 3 cut is too far toward the tip of the key then
enter a positive number in the Depth Offset under CUTTER.
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Show Key Information
The “Show Key Information” button, you can select
this to read available information or add additional
information to the key database. See Below
When you have finished with this information you
can click the “Hide Key Information” button.

Explaining the software: Buttons and Menus
Half Cut
The button “Half Cut” refers to cutting 1/2 depths when using Determinators. When half
cut mode is entered, 1=1-1/2 (one and a half) and 3=3-1/2 (three and a half) etc. You must
still follow the procedures to choose the correct key blank type first.
When using the half cuts you must first click on the “Half Cut” button and the button will
blink red, this assures you that you are in half cut mode. Now you can enter your depths
into the spaces and click “Enter” and then “Start”.
To exit half cut mode, click the “Half Cut” button and the
red blinking will stop. Change the spaces to the correct
numbers and click “Enter”.
If you press “Start” without clicking “Enter”, half cut
mode will not be disabled.
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Reset: Clears all entry boxes to make starting over easier.
Trace: The Trace button is used for duplicating keys.
Start
The “Start” button will only appear after the “Enter” button has been clicked. If any data is
changed, this button will disappear.
DSD (Depth and Space Data)
Every key has its own DSD number. When
clicking on the “Search” Tab, you can enter any
DSD number in the database. Once the DSD has
been entered, press the “Search” button. This
will bring up the key you have selected in the
“Step 2” column.
Key Blank
Tells you what key blank you should be using.
Manufacturer
The manufacturer gives you reference to the
current car you are working on.
Spaces
This value tells you how many spaces are on the
key you are working with.
Depths
This value tells you how many depths are on the
key you are working with.
Track
This tells you how many edges of the key will be
cut. There are 3 different types: Four, Two (Left),
and Two (Right).
Cut
This location explains how the key will be cut,
internally or externally.
Jaw
There are 3 types of jaws: Jaw 1, Jaw 2, and Jaw 3. Once the key is chosen, the software will
indicate which jaw should be used.
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Jaw type & Cutter
Jaw type & Cutter displays a picture of the jaw type and cutter that should be used to cut the
key.
Jaw Clamp
This indicates which side of Jaw 2 you should clamp the key with, A, B, C, or D.
Stop
There are 4 different types of “Stop”: Shoulder,
Tip 1, Tip 2, and Tip 3. Make sure that you insert
the key to the correct tip stop. If not done
properly, you may cut the key wrong or damage
the cutter.
Comment Boxes
There are two comment boxes. The top box
displays default comments about the key, while
the bottom box displays comments that you set
in the edit screen.
The bottom box allows the user to enter notes for a specific key type or comments about the
car type. To edit user comments, you go to the “File” menu and click on “Edit”. Once in the
“Edit” screen, click on the “Edit” button and a dialog box will appear asking you to verify
yourself as an authorized user. Press “Yes” and another box will appear. You do not have to
enter a password. In the “Domain” drop-box, press the down arrow key and choose “This
Computer”, then press “Submit”. After editing the comments, you MUST click on the “Done”
button that has appeared. Failing to do so may cause the software to not recognize the
database.
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Side A / Side B Spaces
The spaces that are needed will show up
according to the type of key blank that is
being cut. “Side A” will be a left-hand cut to
the key, and “Side B” will be a right-hand cut.
If “Side A” and “Side B” are present, it will
cut both sides of the key.
Status
This box displays what the 3D Pro is currently
working on. It also shows the status of the
connection board, whether it has been found
by the software or not. The status box will
also give you the next step in the process of
cutting a key and lets you know when the
process of cutting a key is complete.

Re-Connect
The re-connect button is only used when the board cannot be found. To use this button you
must cycle the power on the machine off and then on again. You may now press the reconnect
button to refresh it with the software. The software can only be refreshed once. If it loses the
connection after it has already been refreshed you must restart the software.
Tech Box
This box is located at the bottom right-hand
corner of the software interface. If you are
having trouble cutting or tracing a key, this
box displays data that the service tech will
use to fix the problem. This also shows the
parameters in which the cutter is going to
cut a key and what the tracing

parameters are measured in
thousandths of an inch (.000”).
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Key Editor
The Edit screen is for displaying all of the information about a key and can be used to edit key
cutting and tracing parameters. The key editor can be used to view and edit key data. The key
editor can be used to edit the Center Distance, Flat Width, Cutter Height, Tracer Height,
Cutting Data tab, Tracing Data tab, and the Flat Widths tab on key DSD’s.
To make a change to a key using the Key Editor, select the key you want to edit and click File
then click Edit.

Click “Yes” to the authorized user warning and Choose “This Computer” as the user name,
leave the password blank and press OK.
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Center Distance: Controls where the center
of a high security internal cut key is located
from the left edge of the Jaw 1 clamp in
thousandths of an inch. Performs the same
as a space and depth adjustment but only
effects
Flat Width and Flat Widths Tab: Controls
size of key flat widths. If all flat widths are
zero in the Tab the all flat widths will be
whatever is entered in the Flat Widths box
Cutter and Tracer Height: Controls how high
the cutter and tracer cuts and traces high
security keys. Controls webbing thickness
when cutting.
Cutting and Tracing Data: Control spaces
and depths.
Other: Create user notes.
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Cut Angles: In the “Flat Widths” tab are the controls for angles on plunge cut keys. Below is an
illustration of the angles on a plunge cut Schlage 5-Pin.

To widen the angles, increase the angle number. To narrow the angles, decrease the angle number.

After editing click the Done button at the
bottom left of the software to save changes.
Half Cut Depth
This is mostly for use with Determinators. When clicking on the “Half Cut” button on the main
screen, it will flash red to indicate that it has been selected. Whatever parameters you have
filled in the “Half Cut Depth” boxes, it will use these instead of the default parameters once
the button has been selected.
Tracing Data
Tracing Data should normally match the “Cutting Data”, but in some cases it will not.
End Cuts
These are pre-defined parameters of how the tip of each key will be cut, these are not in any
way adjustable by the user.
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Troubleshooting
COM Error
If you start your software and the software
says “Communications Error” or “Board Not
Found” check these options:
1. Power is going to your 3D Pro from the
power outlet.
2. The emergency stop button is disengaged
(twisted out according to the arrows)
3. The USB cable from the 3D Pro is plugged
into a USB port on your computer.
4. Multiple instances of the 3D Pro software
may be running causing a conflict. Open
Task Manager by pressing Control Alt Delete
on your keyboard and then clicking Task
Manager. Look for ‘3D Pro Xtreme.exe’, click
it, then click “End Process”
Then start the 3D Pro software again.
Humming
If when you start the software for the 3D Pro and the machine continuously hums, check that
the motor drive cable is plugged into the motor on the left of the main jaw table. You can also
try pressing firmly on the red spindle know sticking out the top of the 3D Pro.

Obstruction detected error
If an obstruction detected error occurs immediately after attempting to trace or cut a key and
before the tracer or cutter actually touches anything then you may have key shavings built up
behind the cutter wheel. Remove the cutter wheel and brush behind it, put the cutter wheel
back on and try the operation again.
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Using an inverter
When using an inverter to power the 3D Pro, make sure the inverter is properly grounded to
the vehicles chassis otherwise you may incur problems with the operation of the Machine.
If a problem occurs that you are unable to repair yourself, please seek the assistance of a
qualified vehicle electrician.
If you plan to use an inverter to power your 3D Pro Xtreme key machine, it is recommended
that you use only a PURE SINE WAVE INVERTER with a CONTINUOUS output rating of at least
1500 - 2000 watts. This is the MINIMUM output rating.
Although Modified Sine Wave inverters have been known to work, Pure Sine Wave inverters
produce a much ‘cleaner’ power signal than Modified Sine Wave inverters and as a result, will
extend your equipment’s life and are much less likely to cause problems with your computer
or 3D Pro Xtreme key machine’s functionality.
It is recommended that you PRECISELY follow your inverter manufacturer’s wiring and
connection instructions when installing your inverter and preparing it for use with your 3D Pro
Xtreme key machine.
However, here are some important points to remember and apply to your installation:
 THIS IS NOT THE PLACE TO START CUTTING CORNERS OR SAVING A DOLLAR!!!
 Unless you are completely confident in your electrical and wiring skills, we recommend
allowing a trained RV electrician or equivalent perform this installation for you.
 Only use an inverter with a minimum continuous power output rating of 1500 - 2000
watts. This is the minimum rating for powering ONLY your 3D Pro Xtreme key machine
and computer. If you plan on powering other lights, devices, machines, etc. at the same
time as your 3D Pro Xtreme key machine, you should add the total power consumption,
in watts, of all the devises you will be powering at once and multiply by 1.25 to
determine the output rating of the inverter that will supply enough power for your
needs. A power measurement device such as a Kill-A-Watt can help you determine your
power requirements.
Amperage rating of the powered devise X Volts = Watts X 1.25
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 Properly grounding your inverter to the vehicle CHASSIS is absolutely essential for
trouble free operation.
 Shorter and fatter is better! Keep your wiring and cabling as short as reasonably
possible. When selecting wire and cable gauges, err on the side of larger diameter
rather than smaller. Your inverter’s manual should have a cable size & length vs. current
load chart included. Follow the manufacturer’s recommendations.
 The instructions included with your inverter should also include ‘supply side power’
wiring diagrams detailing wire/cable routing for several different configurations, i.e.,
one battery, two batteries, etc. Again, follow the inverter manufacturer’s
recommendations.
 It is possible to power your inverter using the vehicle starting battery but is not
advisable. An auxiliary battery system is recommended.
 Use the best deep cycle batteries for your auxiliary battery system that you can afford.
Commercial golf cart batteries give the best performance and longest life.
 Upgrade your alternator to a higher output unit.
 When using the vehicle’s alternator to charge the auxiliary battery system, it is always
best to isolate the auxiliary batteries from the starting battery with either a mechanical
or solid state isolator to prevent draining the vehicle’s starting battery. This should be
covered in the inverter manufacturer’s instructions as well.
 Always use fuses where applicable! Don’t burn your rig to the ground because you
didn’t think you needed a fuse!
 Remove any paint, under coating, dirt, etc., from connection surfaces before securing
the connection. Establish clean, solid, and reliable connections.
 Double check all of your connections to make sure they are solid and secure. Check
them periodically to make sure they remain tight.
Follow these tips and the inverter manufacturer’s instructions and you’ll be rewarded with a
long lasting, trouble free system.
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Example of Inverter Chassis Grounding
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Changing the Fuses
!!Please Disconnect Machine Before Proceeding to Change Fuses!!

Insert a small tipped screwdriver into
slotted area in the front face of the fuse
box located on the left side of the 3D
Pro key machine and pull fuse cartridge
toward you.

Once fuse cartridge is open slide out
until fuses are fully visible

Install new 6amp 250v fuses into
cartridge and push back into fuse box
until cartridge snaps into fuse box.
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Optional Accessories

Bolt Down Kit

Lexus 80000 Code Series Cutter

Tibbe Adapter

Preloaded Laptop

Genericode for 3D Pro

Laptop Mount

Tubular Jaw

Tubular Cutter

LaserKeyProducts.com

